Sub: Information Technology Class: IX

Topic: Digital Documentation

Digital Documentation
Digital: Electronic

Document: A paper something written on it. Ex: letters, notices, reports and
books etc.

Documentation: The process of preparing a document.

Digital Documentation: Any document which is created with the help of any
application or software.

Word Processing and Word Processor:

Word Processing and Word Processor

‘ Word Processing Word Processor

> Word processing is the > Word processor is a
use of computer software computer application used
to enter, edit, format, for production of
store, retrieve and print printable material.
the document. > Ex: MS-Word, Libre
| Office Writer, Google

Docs, Open office writer

Typewriter




» A typewriter is a mechanical machine for typing characters.

» Typically, a typewriter has an array of keys, and each one causes a different
single character to be produced on paper by striking an inked ribbon selectively
against the paper with a type element.

Difference between Word processor and Typewriter
e S e e e e e S e e S S e

Word Processor Typewriter

> You can save the document. > You can't save or backup the
document.

> You can make the changes > You can't make changes or

. without retyping the entire correct the mistakes.

document-.

> It is easy to insert a word or »> It is difficult to insert a

sentence in the middle of a word or sentence in the middle
document. of a document.
> Multiple copies can be -~ » Multiple copies cannot be

created. ~ created.

Features of Word processor

Create, edit, save, retrieve and print the document.

Select and move the text from one place to another in the document.
Copy the text to other places within the document.

Move or copy a selected text from one document to another document.
Check the font style, size of the text in the document.

check spelling and grammar.

Create table, modify the size of the selected rows, columns or cells.
Combine one or more documents.

Insert pictures or graphs within the document.
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Microsoft Office Word

Microsoft Office Word 2007, 2010, 2013, 2016 etc. allows you to create and edit
personal and business documents, such as letters, reports, invoices, emails and
books.

By default, documents saved in Word are saved with the .docx extension.
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Microsoft Word can be used for the following purposes:
» To create business documents having various graphics including pictures,
charts,
and diagrams.
» To store and reuse readymade content and formatted elements such as cover
pages and sidebars.
» To create letters and letterheads for personal and business purpose.
» To design different documents such as resumes or invitation cards etc.
» To create a range of correspondence from a simple office memo to legal copies
and reference documents.
» Word — Getting Started : To open a new MS Word document:
Step1: Click the Start button.
Step 2: Click the All Programs option from the menu.
Step 3: Search for Microsoft Office from the submenu and click it
Step 4: Search for Microsoft Word from the submenu and click it

When you open MS Word document it looks like as follows
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Elements of MS Word:

Quick Access toolbar

- Title bar
File tab B Ruler
Ribbon Help
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File Tab:

You can click it to check the Backstage view. This is where you come when you need
to open or save files, create new documents, print a document, and do other file-
related operations.

Quick Access Toolbar:

This you will find just above the File tab. This is a convenient resting place for the
most-frequently used commands in Word. You can customize this toolbar based on
your comfort.

Title bar:
This lies in the middle and at the top of the window. Title bar shows the program and
document titles.



Ribbon:
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Ribbon contains commands organized in three components:

» Tabs: These appear across the top of the Ribbon and contain groups of related
commands. Home, Insert, Page Layout are examples of ribbon tabs.

» Groups: They organize related commands; each group name appears below
the group on the Ribbon. For example, group of commands related to fonts or
group of commands related to alignment, etc.

» Commands: Commands appear within each group as mentioned above.

Ruler:

Word has two rulers - a horizontal ruler and a vertical ruler. The horizontal ruler
appears just beneath the Ribbon and is used to set margins and tab stops. The
vertical ruler appears on the left edge of the Word window and is used to gauge the
vertical position of elements on the page.

Help:
The Help Icon can be used to get word related help anytime you like. This provides

nice tutorial on various subjects related to word.

Zoom Control:

Zoom control lets you zoom in for a closer look at your text. The zoom control
consists of a slider that you can slide left or right to zoom in or out; you can click the +
buttons to

increase or decrease the zoom factor.

Inserting the Blank Page: To add/insert a blank page into your Word document, place the
cursor where you want the new/blank page.

» Click on Insert tab > Pages group>Blank Page.
» The blank page opens, ready for whatever you want to add.

Entering the text:
Document Area: Document area is the area where you type your text.

Insertion point: The flashing vertical bar in document area is called the insertion point and it
represents the location where the text will appear when you type.



The following are the two important points that will help you while typing:
> You do not need to press Enter to start a new line. As the insertion point reaches the end of
the line, Word automatically starts a new one. You will need to press Enter, to add a new
paragraph.
» When you want to add more than one space between words, use the Tab key instead of the
spacebar. This way you can properly align text by using the proportional fonts.

Text Formatting:

Font Group Clear All Formatting
4

Font Font Size Groéu Font Shrink Font
1

Bold Underline

Subscript Superscript

2 Text Highlight Color
Itali

Strikethrough

To change the font size:
1. Select the text you want to modify.

2. Click the drop-down arrow next to the Font Size box on the Home tab. A
drop-down menu appears.

3. Select the desired font size from the menu. Alternatively, you can type the
value you want and then press Enter on your keyboard.
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You can also use the Grow Font and Shrink Font commands to change the size.
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To change the font:
1. Select the text you want to modify.

2. Click the drop-down arrow next to the Font box on the Home tab.
The Font drop-down menu appears.

3. Move the mouse pointer over the various fonts. A live preview of
the font will appear in the document.
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4. Select the font you want to use. The font will change in the
document.

To change the font color:
1. Select the text you want to modify.

2. Click the Font Color drop-down arrow on the Home tab. The Font
Color menu appears.

3. Move the mouse pointer over the various font colors. A live preview
of the color will appear in the document.
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Franklin Gothic * 36 - A A7 | Aav | E-i=-% [ EE 2] |1

a
g B I U-aex x aﬁ?vggg Y=o | By oine
[ Font . Automatic &

-1+ | Theme Colors "o 0 3 9 0 5

Illllﬁjlll

Standard Colors | Red, Accent 2, Darker 25%

HE l’l’l’l’l"—"
we i3 More Colors... us I n

Ml Gradient

4. Select the font color you want to use. The font color will change in
the document.
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Your color choices aren't limited to the drop-down menu that appears. Select More
Colors at the bottom of the list to access the Colors dialog box. Choose the color you

want, then click OK.

To highlight text:

1. From the Home tab, click the Text Highlight Color drop-down
arrow. The Highlight Color menu appears.
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2. Select the desired highlight color.
3. Select the text you want to modify. It will then be highlighted.

4. To switch back to the normal cursor, click the Text Highlight
Color command.



To use the bold,. italic, and underline commands:

1. Select the text you want to modify.

2. Click the Bold, /talic, or Underline command in the Font group on
the Home tab.
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To change text case: There are five change case. They are as follows.
a. Sentence case
b. Lowercase case
c. Upper case
d. Capitalize each word
e. Toggle case.

Following are the steps to apply change case to the selected text.
1. Select the text you want to modify.

2. Click the Change Case command in the Font group on the Home
tab.

3. Select the desired case option from the list.
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. Organization

The business is owned by me, Jane Doe.

The owner will have full authority over all decisions made .
and train a manager and assistant manager that will be re
manager will report directly to the owner, and the assistan

Move Around
Moving with Mouse:

» You can easily move the insertion point by clicking in your text anywhere on
the screen. There may be instances when a document is big and you cannot
see a place where you want to move.

» You can scroll through your document by rolling your mouse wheel, which is
equivalent clicking the up-arrow or down-arrow buttons in the scroll bar.

Moving with Scroll Bars:
» There are two scroll bars: one for moving vertically within the document,
and one for moving horizontally. Using the vertical scroll bar, you may:
e Move upward by one line by clicking the upward-pointing scroll arrow.

e Move downward by one line by clicking the downward-pointing scroll
arrow.
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iii. Moving with Keyboard
The following keyboard commands, used for moving around your document, also move
the insertion point:

Keystroke Where the Insertion Point Moves
— Forward one character
<— Back one character
1\ Up one line
\L Down one line
PageUp To the previous screen
PageDown To the next screen
Home To the beginning of the current line
End To the end of the current line

You can move word by word or paragraph by paragraph. You would have to hold down the
Ctrl key while pressing an arrow key, which moves the insertion point as described here:

Key Combination Where the Insertion Point Moves
Ctrl + = To the next word
Ctrl + <— To the previous word

To the start of the previous paragraph
cerl+ 1 previous paragrap
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To the start of the next paragraph
cerl + ¥ paragrap

Ctrl + PageUp To the previous browse object

Ctrl + PageDown | To the next browse object

Ctrl + Home To the beginning of the document

Ctrl + End To the end of the document

iv. Moving with Go To Command:

Press the F5 key to use the Go To command. This will display a dialogue box where you
will have various options to reach to a particular page.

Normally, we use the page number, the line number or the section number to go directly
to a particular page and finally press the Go To button.

Find and Replace LM

[ g [ Regace | GoTo |
Go to what: Enter page number:

O . | %
Section —3 :

Line £1| Enter + and — to move relative to the current location. Example: +4 wil
Bookmark move forward four items.

Comment

Footnote 7|
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§avinq Docu ment: Once you are done with typing in your new Word document, it is time
to save your document to avoid losing work you have done on a Word document. Following are the
steps to save an edited Word document —

Step 1 - Click the File tab and select the Save As option.
Fili.-I tab SaveAs

=
(] ’ - Qs Decumentl - Microsoft Word || (B
Haome Insert Page Layout References Mailings Review View Add-Ins ﬂ
oy
b Save )
_ v Information about Document1 ,
] save As {
L Open - Permissions
[ Close -_.!.li_ﬂ] Anyone can open, copy, and
change any part of this
Protect document. ——
Info Dar Properties
Size
Recent Pages
WWords
New = Prepare for Sharing ¢ otal EdHinG T
1#3 | Before shanng this file, be aware Tithe
= that it containg e
Print Check for Document properties and i .
Issues - autheor's name i
Save & Send Related Dates
Help . Versions Last Modified
: {_5‘] %) There are no previous Created
22 adddns - versions of this file. i 5el Printed
s Manage "
. i Versions =
2] Options Related People
E Exit Author
Last Modifled B &
4 il L4

Step 2 - Select a folder where you will like to save the document, Enter the file name which you
want to give to your document and Select the Save As option, by default it is the .docx format.
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Folder to save the document

(W] Save As l‘- — - - ﬁ
”GE | = » Libraries » Documents » - |+1- " Search Documents = I
i Organize = Mew foider E - ﬁ
— e -
(W] Microsoft Word Documents library g Fetdi
Templates Includes: 2 locations -
Activision DigiFish Dolphin My PSP Fi
¢ Fawvaorites
B Deskt Adobe Scnpts Downloads 2 My Sha Pels
esktop Android @« Fonts My Station]
@ Downloads -
B Desit Aptana Studio 3 Workspace Google Talk Received Files Pascal
HE’ “f; ASP idooDVD ShadowEd
e t Pl
e st Blustooth Exchange Folder LDW @ Softwrap
& Confrg microsoft | switch stall
Bl Cesktop .
P cpp_goto_statement_file My Corel Shows Symantec|
— _' s Cyberlink My DAP Downloads ternplates
A | = Documents
a Music S_— (0] (|
File npame: Hello.docx -
Save as fype: { Wold Document (*.docx) - E
Kby A 4
Authors: zara Tags: Add atag
Sgve Thumbnail
1
= lHide Folders Tools - E Save J - Cancel
L 1 — . i !

Folder Mames File Name Document Type

Step 3 - Finally, click on the Save button and your document will be saved with the entered namein
the selected folder.

Saving New Changes:

There may be an instance when you open an existing document and edit it partially or completely,
or an instance where you may like to save the changes in between editing of the document. If you
want to save this document with the same name, then you can use either of the following simple
options -

« Just press the Ctrl + S keys to save the changes.

o Optionally you can click on the floppy icon available at the top left corner and just above
the File tab. This option will also help you save the changes.

e You can also use the third method to save the changes, which is the Save option available
just above the Save As option as shown in the above screenshot.

If your document is new and it was never saved so far, then with either of the three options, Word
will display a dialogue box to let you select a folder, and enter the document name as explained in
case of saving new document.
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Paragraph Formatting in Word:

A paragraph is a different section that describes a particular idea or point. It is with one or more
characters, words, numbers, or any related combination of these. Paragraph formatting or
Formatting a Paragraph can be a little combination of different commands, such as an Indention,
Numbering, Alignments, Line and Paragraph Spacing.

To format a paragraph, you can use different commands such as different text alignments, bullets,
numbering, multi-level list, paragraph indents, sorting text, line spacing, shading, and different
borders. To format a paragraph, follow the steps below the picture.

Paragraph Formatting Group in MS-Word:

{b) Numbering {¢) Multilevel List {d} Decrease Indent (e) Increase Indent

{a) Bullets {f) Sort

{h) Align Left

=, A, {g) Show or Hide Marks

— — = =

{I) Centre Paragraph (n) Borders

{1} Align Right (k)Justify  {I) Une and Paragraph Spacing " {m) Shading

Commands in Paragraph Formatting Group in MS-Word:

Commands of Paragraph Formatting Group in MS-Word are explained in detail below.

« Bullets: To start text/Line/Paragraph with a bulleted list, you can choose
different bullet styles by clicking the drop-down arrow of the Bulleted List.

« Numbering: To start text/line/Paragraph with a Numbered list, you can choose
different Number styles by clicking the drop down-arrow of the Numbered List.

« Multilevel List: To start text/line/Paragraph with a multilevel list, you can
choose multilevel list styles by clicking the drop-down arrow.

« Left Alignment: Aligns text to the Left off the page to format a paragraph.

« Center Alignment: Aligns text to the center of the Page (for paragraph
formatting).
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« Right Alignment: Aligns text to the right of the page.

« Justification: Aligns text to both the right and the left margins of the page by
adding the extra space between words for the clean look in a word document.

« Decrease Indent: Decrease indent means decreasing the gap between the left
margin and left of the paragraph in the document (for paragraph formatting).

« Increase Indent: Increase indent means increasing the gap between the left
margin and left of the paragraph in the document (for formatting the
paragraph).

« Sort: In this, you can arrange the selected text in ascending or descending
order.

« Show or Hide Paragraph Marks: Paragraph Marks are useful and shows the
marks when you apply section or page breaks.

« Line Spacing: Increases or decreases the space between the lines or
paragraphs in the document.

« Shading: Coloring the background of a line from the left margin to the right
margin.

« Border: You can apply different borders to the selected text in the word
document.

Steps to Follow in Formatting the Paragraph in MS-Word:

To apply the Paragraph Formatting Group commands, follow the steps given below

Step 1: Go to the Home tab

Step 2: Select the text or Position the cursor wherever you want to format the paragraph.

Step 3: Then click or select any command that you want to apply to the selected text. That's
the simple steps to apply the Paragraph Formatting to the Word Document.
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Styles

Style: A style is a predefined combination of font style, color, and size that can
be applied to any text in your document.
» Styles can help your documents achieve a more professional look and
feel. You can also use styles to quickly change several things in your

document at the same time.
Applying and Modifying Styles:
To apply a style:

1. Select the text you want to format, or place your cursor at the beginning of the line.

August Volunteer Update

| Ehelbyfield Animal Rescue
August Volunteer Update
A Message from Your Director

It's been a spectacular month for Shelbyfield Animal Rescue and the animals in
our care. Fifteen pets found a new home, including Temple, a longtime resident
of the kennel who was later fostered by Raj and Lisa Beharry. Temple was a staff
favorite who despite his special needs was always up for a rousing game of keep-
away (with the slimiest, grossest tennis ball in the yard).

2. In the Styles group on the Home tab, click the More drop-down arrow.

& Find -
AaBbCcDc| AaBbCcDe AaBbC( AsBbcel AQDB ab
~| | sac Replace
TNormal | NoSpacing Heading1 Heading2 Title E? [+ Select -
Styles & Editing ~

More

Styles give your decurment a
consistent, polished lock.

They also allow you to use the
Mavigation Pane and add a table of
contents,

If you don't like the look of these

styles, check cut the Design tab for
more options.
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3. Select the desired style from the drop-down menu.

aaBbceDc| AaBbcede AaBbC( Asbcel A B
TMormal | Mo Spacing  Heading1  Heading 2 TitIEL}

AaBbCcC AaBbCchi AaBbCcld AcBbCcDi AaBbCcDe
Subtitle  Subtle Em... Emphasis  IntenseE... Strong
AgBbCcDy AanBbCcDi AsMBBCCDL AMBBCCDL AaBbCcli

Cluote Intense Q... Subtle Ref... IntenseR.. Book Title

LaBbCche

T List Para...
A4 Create a Style

Pe Clear Formatting

4, Apply Styles...

4. The text will appear in the selected style.

August Volunteer Update

1 Shelbyfield Animal Rescue

August Volunteer Update
A Message from Your Director

It's been a spectacular month for Shelbyfield Animal Rescue and the animals in
our care, Fifteen pets found a new home, including Temple, a longtime resident
of the kennel whao was later fostered by Raj and Lisa Beharry. Temple was a staff
favorite who despite his special needs was always up for a rousing game of keep-
away (with the slimiest, grossest tennis ball in the yard).

To apply a style set:

Style sets include a combination of title, heading, and paragraph styles. Style
sets allow you to format all elements in your document at once instead of
modifying each element separately.

1. From the Design tab, click the More drop-down arrow in the Document

Formatting group.
18



Animal Rescue - Word
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Document Formatting
2. Choose the desired style set from the drop-down menu.

Animal Rescue - Word

Layout References Mailings Rewview View

Aal This Document

Themes Title

iy 3
7 TPt

[N TR —
[N ——

Built-In
TITLE Tithe TIMLE Title: Title Titke Title:
Henh TIﬂe HEADCA 1t ey 1 Hidg 1
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TLE Tme TLE TITLE Tithe
m Title Title n [ - .
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nciing [ e———— ey — Hmcirg panll
T T Lines (Stylish]
Title
Traty

Reset to the Default Style Set

Save as a Mew Style Set...

3. The selected style set will be applied to your entire document.

August Volunteer Update

Shelbyfield Animal
Rescue

AUGUST VOLUNTEER UPDATE

A Message from Your Director

It's been a spectacular manth for Shelbyfield Animal Rescue and the animals in ocur
care. Fifteen pets found a new home, including Temple, a longtime resident of the
kennel who was later fostered by Raj and Lisa Beharry. Temple was a staff favorite
who despite his special needs was always up for a rousing game of keep-away [with
the slimiest, grossest tennis ball in the yard).
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To modify a style:

1. In the Styles group on the Home tab, right-click the style you want to change and
select Modify from the drop-down menu.

e
aaBbccod  Aaebcedd AQBD! A\dC . )

- Ec Replace
THMormal Mo Spacing  Heading 1 Heading 2 Title = P e
Update Title to Match Selection
Styles L
gﬂg Modify...

Select &ll: (Mo Data)

Rename...

Remove from Style Gallery

Add Gallery to Cuick Access Toolbar

2. A dialog box will appear. Make the desired formatting changes, such as font
style, size, and color. If you want, you can also change the name of the style.
Click OK to save your changes.

Modify Style ? e
Properties
MName: Title
Style type: Linked [paragraph and character]
Style based om: T Mormal -
Style for following paragraph: T Mormal b
Formatting
Calibri Light (Heac |36 [v] B I U | I -
12
= = = =14 £ = = T= 4= | g= 3=
— — 18 — == -
18
20
22
24

Shelby% ld Animal Rescue

T2

Font: [Default] =Headings [Calibri Light), 36 pt, Font colorn: Text 1 -
Line spacing: single, Space
After: 0 pt, Don't add space between paragraphs of the same style, Style: Linked, Show in
the Styles gallery, Priority: 11 b

Add to the Styles gallery |:| Automatically update
@ Only in this document l:::l Mew documents based on this template

Format = OK Cancel
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3. The style will be modified.

August Volunteer Update

1 Shelbyfield Animal Rescue

AUGUST VOLUNTEER UPDATE

A Message from Your Director

It's been a spectacular month for Shelbyfield Animal Rescue and the animals in our [
care, Fifteen pets found a new home, including Temple, a longtime resident of the
kennel who was later fostered by Raj and Lisa Beharry. Temple was a staff favorite l

v
who despite his special needs was always up for a rousing game of keep-away (with ’
the slimiest, grossest tennis ball in the yard).

When you modify a style, you're changing every instance of that style in the
document. In the example below, we've modified the Normal style to use a
larger font size. Because both paragraphs use the Normal style, they've been
updated automatically to use the new size.

g = ) = o = ey =a3= | A . _ = -
S =i 3= 2l T aaBbcep asBbcend AgBbt AzBbc AL
B-FT-p-E=E== = TMormal | Mo Spacing Heading1  Heading 2 Title
] Paragraph ] Styles
August Volunteer Update

Shelbyfield Animal Rescue

AUGUST VOLUNTEER UPDATE

A Message from Your Director

th‘s been a spectacular month for Shelbyfield Animal Rescue and the j
animals in our care. Fifteen pets found a new home, including Temple, a
longtime resident of the kennel who was later fosteraed by Raj and Lisa .A\
Beharry. Temple was a staff favorite who despite his special needs was ]

always up for a rousing game of keep-away (with the slimiest, grossest
tennis ball in the yard).

This was a big month for Arthur too, our lovable yellow lab mix with the ‘L
submissive smile. Through the generous donation of Dr. Giuliani's time and resources, Arthur
received much-needed hip surgery. He's recovering nicely in foster care with Joy Ramirez and
her two young children, who are teaching Arthur to “speak” while he's on bed rest.
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To create a new style:
1. Click the arrow in the bottom-right corner of the Styles group.

L - A Find -
aaBbceD Aasbcedd AgBbi AaBbC AL L
* | | fac Replace
TMermal Mo Spacing | Heading 1 | Heading 2 Title = h Selact «
Styles & Editing S
Styles (Alt+Ctrl+Shift+35)
== Preview, manage and customize the
= x text styles in Word.
? Use the window to see and edit
: formatting details for each style,

create new styles, and quickly
preview styles in your document,

a | R e S C u e T You can also update styles to match

selected text.

2. The Styles task pane will appear. Select the New Style button at the bottom of the

Intense Quote
Subtle Reference
Intense Reference
Book Title

List Paragraph

Footer

task pane.
Styles %

Clear All
Mormal v
Mo Spacing a
| Heading 1 ﬁl
Heading 2 a
Title Ia
Subtitle Ia
Subtle Emphasis a
Emphasis a
Intense Emphasis a
Strong a
Quote Ia
a
a
a
a
T
Ia
Ta

Header

Show Preview
Disable Linked Styles

zﬂ:‘\? ‘i’fj;. ‘5} Options...
Mew Style
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3. A dialog box will appear. Enter a name for the style, choose the desired text
formatting, then click OK.

Create Mew Style from Formatting ? =
Properties
Mame: Mew Style
Style type: Paragraph s
Style based on: T4 Heading 1 e
Style for following paragraph: M Mew Style s
Farmatting

Segoe Ul Semiligh|~ || 24 v| BE| I U |

I e
3£
{1 1h
il
it

==:.fl
= = = | .

A Message from Your Director

Font: Segoe Ul Semilight, 24 pt, Bold, Font color: Accent 5, Style: Show in the Styles gallery
EBased on: Heading 1

Add to the Styles gallery |:| Automatically update
(®) Only in this document () Mew documents based on this template

Format - Cancel

4. The new style will be applied to the currently selected text. It will also appear in
the Styles group.

Animal Rescue - Word

Design Layout References Mailings Rewview View Q Tell me what you want

[ SegoeUlSemi - (24 ~|A A" Aa- o iz -iZ-tn- =200 T I AQB | Asebced assbeend ABb
Paste o B I U -akx x° A~ - A~

I
I
il
*
1
4

T Mew Style. THormal Mo Spacing Heading 1

Clipboard = Font [F] Paragraph

&l

Styles

August Volunteer Update

Shelbyfield Animal Rescue

AUGUST VOLUNTEER UPDATE

IlA Message from Your Director

It's been a spectacular month for Shelbyfield Animal Rescue and the

animals in our care. Fifteen pets found a new home, including Temple, a
longtime resident of the kennel who was later fostered by Raj and Lisa
Beharry. Temple was a staff favorite who despite his special needs was
always up for a rousing game of keep-away (with the slimiest, grossest
tennis ball in the yard).
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Using Find and Replace:

When you're working with longer documents, it can be difficult and time
consuming to locate a specific word or phrase. Word can automatically search
your document using the Find feature, and it allows you to quickly change
words or phrases using Replace.

To find text

1.From the Home tab, click the Find command under Editing group.
Alternatively, you can press ctrl+F on your keyboard.

&= - X

Olenna Mason Q,_ Share

S Find -

2 _Rebsice

»CeD. AaBbCel | _

title Subtle Em... | ¢ % Select ~

I Editing ~
Find (Ctrl+F)

Find text or other content in the
document.

2. The navigation pane Will appear on the left side of the screen.

3. Type the text you want to find in the field at the top of the
navigation pane. In our example, we'll type the word we're looking

= =
File Home Insert Design Layout
- . -
‘ " Times 12 A A
Paste : B 7 U -ase x, X A -
- ~ Format Painter
Clipboard -] Font
g q - L
Navigation *
fiction x - o

25 results - || -

Headings Pages Results

publishes superb essays, literary criticism, =
fiction, poetry and, of course, reviews of
current

outlook, His first published work of -
fiction, “Old Scratch in the Valley,” which .
appeared B
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4.1f the text is found in the document, it will be highlighted in yellow
and a preview of the results Will appear in the navigation pane. Alternatively,
you can click one of the results below the arrows to jump to it.

. . [
Navigation X h=
fiction Bt
Result 2 of 25 [ S E} -

Headings Pages Results

publishes superb essays, literary criticism, fiction, poetry
and, of course, reviews of current

outlook. His first published work of fiction, “Old Scratch <
in the Valley,” which appeared )

a work of Agrarian sentimentalism than it is fiction, as
Mark Lucas argues in The Southern Vision

from Southern Agrarianism to Southern fiction. Lytle's
first novel, The Long Night, was

significant change in the Sewanee Review's contents was .
revealed: fiction (Editorial History 7). -

The addition of fiction was strongly supported by Tate. As
he suggests, “good creative work is a

in itself is the end of criticism” (Tate 64). Fiction has been
a mainstay of the Sewanee Review

the similarity of themes and style in their fiction. Lytle
discusses one of his concurrent themes

any of Lytle’s former vocations, teaching fiction writing

5.When you are finished, click the X to
highlight will disappear.

Navigation

bl o o

TS S e B AT
T T T T e P e T e e TSP O e

the late 1960s. After a short stint on the Broadway circuit, Lytle published
Forrest and his Critter Company, a biography of the Confederate general,

Throughout the early thirties, as throughout his career, Lytle maint
Agrarian outlook. His first published work of fiction, “Old Scratch in the
appeared in the Virginia Quarterly Review in 1932, is more distinctly a we
sentimentalism than it is fiction, as Mark Lucas argues in The Southern Vi
“No one would make great claims for the story as art....Point of view is cl
content is self-consciously provincial in the manner of local-color writing;
evasion at the climax™ (52). Such essays as “The Backwoods Progression
Secures the State” follow the direction of Lytle’s earlier Agrarian writing.
recognized the weakness in this kind of writing when applied to literature,

much later in career: “When a novel obviously makes an appeal other thar

close the navigation pane. The

fiction X ~Close:
25 results A | v :
Headings Pages Results _
publishes superb essays, literary criticism, -

fiction, poetry and, of course, reviews of -

current

For more search options, click the drop-down arrow next to the search field.
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Navigation ToxLE :
fiction x -

25 results ) Options...

Headings Pages Results £ Advanced Find...

ab
publishes superb essays, literary criticism, ¢ Replace...

fiction, poetry and, of course, reviews of = Go To...
current

Find:
outlook. His first published work of l.d Graphics
fiction, “Old Scratch in the Valley,” which "~ N
appeared EZ Tables

a work of Agrarian sentimentalism than it TU Equations
is fiction, as Mark Lucas argues in The
Southern Vision

AB' Footnotes/Endnotes

[ J Comments »
from Southern Agrarianism to Southern -

fiction. Lytle's first novel, The Long Night,

P

To replace text

At times, you may discover that you've made a mistake repeatedly throughout
your document—such as misspelling a person's name—or that you need to
exchange a particular word or phrase for another. You can use Word's Find
and Replace feature to quickly make revisions. In our example, we'll use Find
and Replace to change the title of a magazine so it is abbreviated.

1.From the Home tab, click the rReplace command. Alternatively, you can
press Ctrl+H on your keyboard.

& — X

Olenna Mason 9,_ Share

L Find ~
ab_ Replace
Subtitle Subtle Em... | < % Sel =

aBbCcD AdaBblCcl

™~ Editing ~
Replace (Ctrl+H)

Search for text you'd like to
change, and replace it with
something else.
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2. The Find and Replace dialog box will appear.

3. Type the text you want to find in the Find what: field.

4. Type the text you want to replace it with in the Replace with: field.

Then click Find Next.

Find and Replace ?
Find Replace Go To
Find what: Sewanee Review
Replace with: SR
More >> Replace Replace All Find Next Cancel
I,

5. Word will find the first instance of the text and highlight it in gray.

6. Review the text to make sure you want to replace it. In our example,
the text is part of the title of the paper and does not need to be
replaced. We'll click Find Next again to jump to the next instance.

T L T T L T T T T N S R T SR S S N SRR SRR

William Fisher LIT 489

Andrew Lytle at The Sewanee Review

G 7

Atop Monteagle Mountain at the University of the South in Sewanee, Tennessee, is the

offic| Find and Replace ?

olde Find Replace Go To

Find what: Sewanee Review
mag{
polit]

Replace with: SR
regu.

currg

More >> Replace Replace All Eind Next Cancel
grea k

X

as the

ly, the

of

m the
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7. 1f you want to replace it, you can click Replace to change individual
instances of text. Alternatively, you can click Replace All to replace
every instance of the text throughout the document.

Atop Monteagle Mountain at the University of the South in Sewanee, Tennessee, is the
office of The Sewanee Review. Founded in 1892, the Sewarnee Review (SR) has never missed an
issue, distinguishing it as the oldest continuously published quarterly review in the United States.

For its first half-century, the magazine existed as a general journal of the Humanities, featuring

Find and Replace ? X
Find Replace Go To
Find what: Sewanee Review y
Replace with: SR v
More >> Replace Replace All Eind Next Cancel
I

8. The text will be replaced.
current books. This shift in tone was facilitated expressly by the editors of the t
great deal of the magazine’s continued excellence has depended on its editors,
' SR ‘;\/011ld not have been able to solicit and select the excellent writers that have

pages during these past decades. For the last seventy-six years, the office of the

9. When you're done, click Close or Cancel to close the dialog box.

For more search options, click More in the Find and Replace dialog box. From
here, you can select additional search options, such as matching case and
ignoring punctuation.
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Find and Replace ? X
Find Replace Go To
Find what: Sewanee Review v
Replace with: |SR v
More >> Replace Replace All Eind Next Close

Clipboard Group (Cut, Copy, Paste and Format Painter):
» Clipboard Group is the first group of Home tab in Microsoft office. This
group contains four options such as Paste, Cut, Copy, and Format

painter.
Use Clipboard Group in Microsoft Word

These are all the options that we have in Clipboard group

o Paste (Ctrl+V), this group is used to paste the data which you have copied
or cut from other document or other position of the same document.

o Cut (Ctrl+X), this option is used move or remove your data from one
position or document to other position or document.

o Copy (Ctrl+C), this option helps you to have a copy of your data in other
documents. The deferent between Cut and Copy is this that in copy
option your main data will not remove. Just you will have a copy of your
data in other documents.

o Format Painter (Ctrl+Shift+C, Ctrl+Shift+V), this option helps you to use
the exact format of your text to other text.
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H 3 T &-‘ & Document] - Word

File Insert Design Layout References Mailings View Foxit Reader PDF @ Tell me what you want to do...

=l Cut i ey
D Times Mew F ~ |16 A A | A2~ | A

- == Ml T | AaBbC| AaBbC aaBbce AaB

Paste , . .. oA . === 1=, o B T ing | i
2 afcs i B I U ~abe X, X A 7 - A = By ¢ TNormal | TMNoSpac... Heading 1 Title

Clipboard Pt Font T Paragraph P Styles

Clipboard Group in Home Tab

Stepl. Paste Your Data in Deferent Format:

o Through the paste option, you can paste your file that you have copied or
cut from other office applications in deferent format. Here also you can
paste them in deferent format, but frankly, it depends on the version of
your office. In the old version you cannot paste your file in every format,
just you can paste as simple text. Here you have two ways to paste your
files, first directly paste from clipboard option. Or click on paste option to
use paste in deferent format and design such as

o Keep Source Formatting, this option pastes your file with their own
format and tables. This option keep your first file format without any
changes

o Use Destination Style, this option paste your file according to design of
page and changes your file shape to keep the page destination from right
side and left side

o Link & Keep Source Formatting, within this option, if your file have link
here can paste with their source formatting with links without any

changes
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o Link & Use Destinations, here they will keep your link but according to
the destination of the page

o Picture, this option will paste your file as a picture without any small
changes but according to your page destination

o Keep Text only, through this option you can paste just your text without
any table or own source formatting.

L-A- Document] - Waord

Insert Design Layout References Mailings View Fonit Reader PDF Q@ Tell me what you want to do...

Paste o4 . : | @, Ak I - : -
- ¥ Format Painter B I U -abex x A-%-A = = = = Ly - 1 T Mormal | TMNoSpac.. Heading 1 Title
Paste Options: Font P Paragraph r Styles
g 1 1 1 2 [ 3 1 4 1 5. 1 L, 74
Yex
Ne Iema
MeponpuaTie 30000 =OFFSET{McxoaHbie!B1,B3,0)

1
K-Bo uacos paGoTsl 1 00000 =MeK!C3*OFFSET(MexoambelD1,B4,0)
MecTo npoEeTemms 3 50000 =DFFSET(McxoaHbIe!G1,B5,0)
1
3

K-e0 qacoe 250000 =Mer!C5*OFFSET(McxoaHbe!l1,B6,0)
Memo 10000 =OFFSET{Mcxoaxbie! L1,B7,0)
3 Jon. Yoy FALSE 0 =IF(B8,1,0)
2 4 15000 =OFFSET(McxoaHbIe!01,B9,0)
Hroro 350000 =C4+CH+CT+CI*CB

o Paste Formats

o But next, you have a special that you can select and make your own paste
option that you want.

Step 2. Copy or Cut Your File From Your Document:

o Here you can easily select your intended file or text and cut or copy from
here. But the easiest way to copy or cut your file after selecting the file
you can right click on and cut or copy the file.
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The Crow and the Pitcher [Compatibility Mode] - Word

Layout References Mailings Review View Foxit Reader PDF Q@ Tell me what you want to do...
s ¥ Cut S0 . v K | =, A= e e A
D Bac Avial »l12 A A |Aa- S LiE LN, EEE M 29 A astscin ASBEC AGEBG ASBH
=I5l opy
Paste - b aby . s EE==. = o 1 ing ing 2 i
2 ¥ Forrmat Painter B I U ~abe X, X v - A = = = = £y - 1 TMormal | TNo Spac.. Heading1 Heading2 Title
Clipboard P Paragraph (] Styles
L 5 1 2 3 [ TS TR T Ry,
The Crow and the Pitcher
Arial -z - A A Ags
-

A Crow perishing with thirst < W s to it with
ight. \Fu)'\."hen hg reached it, B I UW-A-~iz-i=- sl 1 little water
could not possibly get ar . Ae tnea everyming ne coula mink or 1o reach the
water but all his efforts werfg® pesie T St stones as he could
carry and dropped them on o Cut until he brought the
water within his reach and By

Copy

Mecessity is the mother of int 'y Paste Options:

Paragraph...

Smart Lockup

V>

o Cut and Copy Your File

Step 3. Use Format Painter to apply easily a particular format to other text in
your document:

o In this step, you can choose a particular format and design for your text
or subheading. And through to this option you can apply that format and
design on other texts. To use this option first select your text and bring
your changes then double click on Format Painter then use the cursor to
select to apply this format to them.

lllustrations and Drawing

In addition to inserting and formatting text into your document, MS Word also
allows you to insert text boxes, lines, shapes, images, ClipArt, and WordArt,
through its image and drawing features. In this section, we will cover the
diversity of these illustration functions in Word, as well as how to use them
most effectively.
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Finding the lllustrations Icon Group

The first step to inserting pictures or drawings in Word is accessing
the lllustrations icon group in Insert tab.

@ & :

FILE HOME IMSERT DESIGM PAGE LAYOUT REFEREMCES

Beowrs P2 [0 [0 B ]

[] Blank Page ) :
L Table  Pictures Online Shapes SrartArt Chart Screenshot
' Page Break - Pictures = -

Pages Tables Illustrations

Figure 4-1
As shown in Fig 4-17 above, the lllustrations icon group can be accessed by
clicking on the INSERT tab just above the icons on the ribbon.

Adding Pictures

@ E (_.) T =

FILE HOME IMSERT DESIGM PAGE LAYOUT REFEREMCES
ﬁCnverF‘agev D | | l-_--|—-~.| r
[ Blank Page S gR:s O S | I &+

L Table JPictures| Online Shapes SrartArt Chart Screenshot
' Page Break - Pictures - -

Pages Tables Ilustrations

Figure 4-2
Step 1. To insert a picture saved on your hard disk, first select the Pictures icon
from the ribbon menu.
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[ El Insert Picture

% &l » Libraries » Pictures » Search Pictures Fel

= -~ [ @&

Organize MNew folder

-~

CE Microsoft word  —  Pictures ||l::frar§g,.r Amange by: Folder ~
Includes: 2 locations

54 Fawvorites -
Bl Desktop
& Downloads
&, Google Drive

.
7=l Recent Places

-

]

Sample Pictures

- Libraries
@ Documents
J’i Music
=] Pictures

B videos

/& Computer

-

File name: Cicero - All Pictures -
Tools - Insert Iv Cancel

Figure 4-3
Step 2. A new window will appear, prompting you to indicate where on the hard
disk the picture you want to insert is located. Once you have located the picture,

click on the Insert button.
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Figure 4-4
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Step 3. Once the picture has been inserted, move the cursor anywhere over it,
clicking and dragging to move it to where you want it on the page.

PICTURE TOOLS
VIEW FORMAT
E Picture Border = .1EBring Forward - |:'_
= | O Picture Effects = 0O Send Backward -
7| 5L Picture Layout - pDEi,tiDn ;.-ME:;FI, Ell; Selection Pane “k
" A InLine with Text
~ Square
= Tight
= Through
= Top and Bottomn
=  Behind Text
F£  InFront of Text

£

| Edit Wrap Points
niis exquisitague doctrina philosophi
ut hic noster labor in varias reprehens
ctis, totum hoc displicet philosophar
rantum studium tamgue multam opet
ri Graecis litteris, contemnentes Latir
rema aliguos futuros suspicor, qui me
nae tamen et dignitatis esse negent.

Move with Text

<,

Fix Position on Page

im|

More Layout Options...

Set as Default Layout

Figure 4-5
Step 4. When the picture is selected, the ribbon menu at the top will change to
reveal the Picture Tools set of options. Using this menu, you can change the way
the text wraps around the picture you have just inserted, by clicking on Wrap
Text icon to reveal the drop-down menu. For the purpose of this tutorial, we
will choose the Tight text wrapping option.
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quis est, gui alienas modum statuat industriae? nam ut
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scripta dicunt contemnere. In guibus hoc primum est in
tet ecs sermo patrius, cum idem fabellas Latinas ad
is enim @@am inimicus paens nomini Romano est, qui Ennii
t, quod se isdem Euripidis fabulis delectari dicat, Latinas

Figure 4-6
Step 5. Now that you have selected how you want the text to wrap around the

picture, moving the cursor to its edge, you can click and drag to move or re-
size it.
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Figure 4-7
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Step 6. Once the picture has reached the desired size and location on the page,

you can format it further using the ribbon menu. For instance, you can change
the color of the picture's border.

Tip. If the Picture Tools do not show up on the ribbon menu, double-click on

the picture.

Inserting ClipArt

If your network or internet connection is active, you can insert ClipArt from

Microsoft's online database.

B H ©- -

FILE HOME
B3 CoverPage~
[ Blank Page

B8

Tahle
= Page Break -

Pages Tables

DESIGM PAGE LAYOUT REFEREMCES

Y Bl e

Online Bhapes SmartArt Chart Screenshot
Pictures| - -

O

Pictures

[lustrations

Figure 4-8
Step 1. To insert ClipArt, click on the INSERT tab, and select Online Pictures.
»
Insert Pictures
I'j {E.:I:Jf.],c;c:frzllfﬂsﬂccllgs}.::}d illustrations romel
Bing Image Search
Search the web
Sign in with your Microsoft account to insert photos and videos from Flickr, SkyDrive, and other sites
Figure 4-9
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Step 2. In the dialog box, type in a subject in the Office.com Clip Art search
field, and press Enter.

x
1 BACK TO SITES
I] Office.com Clip Art
¥ rome
105 search results for rome

F
=

ancient, architectural, architecture, arenas, bui... Pl et N Cancel

683 x 1024 o S e
Figure 4-10

Step 3. Select the ClipArt image you want from the list of results that appear,
and click Insert to add it to your document. You can move, re-size, format, or

change text wrapping using the same method as pictures added from your hard
drive (see Steps 3-6 above under Adding Pictures).
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Inserting Shapes
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Figure 4-11
Step 1. To insert a shape, click on the INSERT tab. clicking on Shapes, select the
desired shape from the drop-down menu. Because this option is used quite
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frequently, we will select Text Box under Basic Shapes, for the purpose of this
tutorial.
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Figure 4-12
Step 2. Then, direct the crossbar to the desired place on the page, where you
would like the shape to be inserted. Then, press and hold the left mouse button,
dragging the cursor to change the size of the shape. When it reaches the desired
size, release the mouse button.
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Step 3. Once the shape has been created, the Drawing Tools now appear in the
ribbon menu, allowing you to change the shape in relation to the surrounding
text. Click on the Wrap Text icon to reveal different wrapping options. In the
case of a text box, you can click anywhere inside the box itself and begin typing
to enter text.
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Figure 4-14
Step 4. In the drop-down menu that appears, select how you want the text to
wrap around the newly created shape. As above, in this tutorial we will select
a Tight text wrapping option. Notice also, that the default settings for a newly
created shape is to be in front of the text, and to move whenever the text itself
is moved (i.e., to another part of the document).
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Figure 4-15
Step 5. Now that you have selected how you want the text to wrap around the
shape, moving the cursor to the edge, you can click and drag to move or re-
size it. If it is a text box, you can click inside of it and enter your text, formatting
it as needed.
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Step 6. Once the shape has reached the desired size and location on the page,
you can format it further. For instance, you can change the color of the
shape's fill or outline, or choose to have both be transparent. For the purpose
of this tutorial, we're going to select No Outline.
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Figure 4-17
A shape has now been successfully inserted into the document. If you ever want
to go back and change the layout options, click on the shape, and then click on
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the icon to the right of the shape. Further formatting options are accessible via
the ribbon menu after double-clicking on the shape.

Commonly Used Shapes

Now that we have gone over the basics of inserting shapes, we will now look at
the more commonly used shapes that are available in Word 201 3.

Lines

E H - -
HOME IMSERT DESIGM PAGE LAYOUT REFEREMCES I12d

B3 Cover Page - D l__l ) r
[ Blank Page : J = I I e+ o
L Tabkle  Pictures Online |ShapesSmartart Chart Screenshot Apps f
'— Page Break - Pictures - - Office
Pages Tables Recently Used Shapes
B~ ~OoOALL=LL O
CORRTAVE SN Ik g

Lines

NS L LL 2 29N

Line

IS I N A B
Basic Shapes

0 &

r
[l I@I I:> [:}
— QW
~Jan
~@TD

C
©
{r
ock

QI

-

OGH

Qre
ﬁ‘%t}
S0

®

OO
ga)
el

[l
-

Arrows

SRR R e Y g (= iy
& @m0 2 [phJddlf
4P Ep @

Equation Shapes

q9F = 8% = = g4

Flowchart
O0<cmoooUlaeoday
CUOAX DB X ¢« AVAD
Qs O

Stars and Banners

TR e I @ @6 6 5 0
&k TF ik TE [T .3 CI 00

Callouts

LAC3¢D E A0 A (AT AL T AT AT
;- A0 A0 dO

&m

E’_) Mew Drawing Canwvas

Figure 4-18

44



Step 1. To begin drawing a line, first click on the INSERT tab above the icons on
the ribbon menu, and then Shapes, selecting the line you would like to insert.
In this tutorial, we will select the most basic option, the line to the farthest left.

Figure 4-19
Step 2. Then, direct the crossbar to the desired place on the page, where you
would like to insert your line. Click and hold the left mouse button, and drag
across the page to draw the line. When it has reached the desired length, release
the mouse button.

Tip. Holding down the Shift key while drawing a line will keep it uniformly flat,
diagonal, or upright.
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"Jq;lr"

Figure 4-20
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Step 3. If you want to move the line, place your cursor just above it, until you
see the move symbol. Click and hold the left mouse button, dragging to relocate
the line, and then release.

Arrows

Figure 4-21

There are two types of arrows available in Word 2013, namely line
arrows and block arrows. Both can be found under the Shapes menu after
clicking on the INSERT tab (see Fig. 4-18 above). Block arrows have their own
grouping under the same menu. The only difference between drawing arrows
and lines is to keep in mind that the arrow will point away from the starting
point. Otherwise, the procedure for drawing arrows is the same as drawing lines
(see Lines above).
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Rectangles
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Figure 4-22

After selecting the rectangle option in the Shapes menu (see Fig. 4-78 above),
click and drag from one corner to the other to create the rectangle. Drawing
rectangles is similar to drawing any other shape, except that holding down
the Shift key will cause it to be a perfect square. The fill of the rectangle can be
changed by clicking on the Shape Fill option under the Drawing Tools. If they

are not immediately visible, these tools can be accessed by double-clicking on
the rectangle itself.
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Ovals

Figure 4-23

After selecting the oval option in the Shapes menu (see Fig. 4-18), drag the
cursor from one corner to the other, holding down the left mouse button. As
with rectangles, drawing ovals while holding the Shift key will perfect the shape,
in this case making it a perfect circle.
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Figure 4-24
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Text boxes are free-floating boxes that are able to display text without
changing the formatting of the body text behind or around it. To insert a text
box, simply click on the INSERT tab, and select Text Box to access the drop-
down menu (see Fig. 4-24a below). For more information on inserting text
boxes and other shapes, see /nserting Shapes). Once you have drawn the box,

simply click inside it to add text. The text you enter can be formatted just like
the body text.
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Figure 4-24a

[Back to Top]

SmartArt

In addition to the Text Box feature, Word 2013 also includes a feature
called SmartArt, which allows you to represent ideas in diagram format.

E H :

FILE HOME IMNSERT DESIGM PAGE LAYOUT REFEREMCES
E Cover Page - D lj‘ l__‘ |_—||
[ Blank Page - = I I [ I

L Table  Pictures Online Shaped Smartdrt | Chart Screenshot
' Page Break - Pictures - -

Pages Tables Ilustrations

Figure 4-25
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Step 1. To insert SmartArt, click on the INSERT tab, and select SmartArt under
the lllustrations icon group on the ribbon menu.
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Figure 4-26
Step 2. A window will appear, prompting you to pick the kind of SmartArt
graphic you would like to use. After selecting one from among the many options
available, click OK.
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Step 3. Format the text of the SmartArt graphic either by clicking on the text, or
using the outline to the left of the graphic.
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Figure 4-28

Step 4. Using the ribbon menu while the SmartArt graphic is selected will allow
you to further format it, changing various elements of its design. To move or
re-size your graphic, or to change the way the text wraps around it, see Steps
3-5under Adding Pictures.
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Charts

Drawing charts has been a feature of Word since its inception, but in 2013 there
are many more options available.
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Figure 4-29
Step 1.To insert a chart, click on the INSERT tab, selecting Chart under
the lllustrations icon group on the ribbon menu.
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Step 2. Select what kind of chart you wish to insert, and then click OK.
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Figure 4-31

Step 3. Once the chart has been inserted, you can use the Excel popup window
to edit the different fields. To format anything on the chart, simply click on what
you would like to change. You may also use the ribbon menu. If you would like
move or re-size your chart, or to change the way the surrounding text wraps
around it, see Steps 3-5 under Adding Pictures.

[Back to Top]
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Screenshots

A newer feature in Word is the ability to insert screenshots into your document,
using the program rather than simply the print screen function of Windows.
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@4 ccreen Clipping

Figure 4-32
To insert a screenshot into your document, click on the INSERT tab,
selecting Screenshot under the lllustrations icon group on the ribbon menu. A
drop-down menu will appear, showing you screenshots of all your open
windows. To select one, click on it. Once it is inserted, you can further format
it. If you would like move or re-size the screenshot, or to change the way the
text wraps around it, see Steps 3-5 under Adding Pictures.

Inserting a Screen Clipping

If you don't want to insert a screenshot entire window into your document, you
can take a screen clipping. The Screen Clipping option is found at the bottom
of the Screenshot drop-down menu (see Fig. 4-32 above).
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Figure 4-33
Once you have selected the Screen Clipping option at the bottom of
the Screenshot drop-down menu (see Fig. 4-32above), Word 2013 will
minimize, and the screen will become grey. A crossbar will also appear, allowing
you to click the left mouse button, and drag the cursor to encompass the area
of the screen you would like to clip. Once you release the left mouse button, the
screen clipping will appear in your document (see Fig. 4-34 below).
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Figure 4-34
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WordArt

WordArt is another popular feature of Word, which allows you to enter free-

floating text without needing a text box. This feature is most useful for
posters, flyers, announcements, etc.
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Figure 4-35
Step 1. To insert WordArt, click on the INSERT tab, and select WordArt to access

the drop-down menu, which will present the varied WordArt styles for use in
your document.
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Step 2. Once the WordArt has been inserted, you may type in your text, and
format it further. You can change the appearance of the WordArt you have
inserted by accessing the WordArt Styles options in the ribbon menu, which are
visible when the WordArt is selected.

Formatting

Although many of the options for formatting shapes and illustrations are close
at hand in Word 2013, you may have need of more advanced formatting options.
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Figure 4-37

Step 1. To access the formatting menu, right-click on the shape or illustration,
and select the option to format it at the very bottom of the menu that appears.
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Figure 4-38
Step 2. A formatting menu will then appear on the right side of your screen,
giving access to advanced formatting options.
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Text Wrapping

There are a variety of different ways that you can wrap text around shapes or
illustrations. What follows are some of the different methods of text wrapping
available in Word 2013. The options for text wrapping are most easily accessed
by the icon which appears next to the shape or illustration (see Fig. 4-39 below),
or by selecting the FORMAT tab, and clicking on the Wrap Text icon. Both are
made available by clicking on the shape or illustration.
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Figure 4-39

For even more advanced formatting, click on the See more option at the bottom
of the LAYOUT OPTIONS menu.

[Back to Top]

Methods of Text Wrapping
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Figure 4-40

This is the normal kind of text wrapping for most small shapes and
illustrations, and is often the default setting. If the object is small enough, it
will not force the text to the next line. This method of text wrapping anchors,
so to speak, the object to the surrounding text and moves with it as if part of
the text itself.
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Square with Text
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Figure 4-41

Square text wrapping wraps the text around the object in a rectangular fashion.
Unlike the inline option, the object does not remain anchored to a particular line
in the text, but rather causes the text to move around it.
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Figure 4-42

The tight text wrapping option keeps the text as close as possible to the object.
For instance, if the object is circular, the text will surround it in a circular
fashion.
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Top and Bottom
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Figure 4-43

This method of text wrapping places the text above and below rather than
around the object. This method is particularly useful for charts, graphs, or
illustrations  which  span  the  breadth of the page itself.
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Behind Text
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Figure 4-44

This method prevents the object and the text from being affected by one
another, and causes the object to be placed behind the body text of the
document.
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Figure 4-45

This option causes the object to behave in a similar fashion to the behind text
option, only it is placed in front of the text rather than behind it.
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